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Preface

Welcome to the TB9100 Calibration Software User’s Manual. This manual
provides you with information about the Tait TB9100 Calibration Software in
PDF format. You can view it online or print it if you want a paper copy. It
describes how to use Version 03.00 of the Calibration Software.

Typographical Conventions

‘File > Exit’ means ‘click File on the menu bar, then select Exit’.

Associated Documentation

B Online Help. The Calibration Software also has online Help. It contains
more or less the same information as this manual. To view it, start the
Calibration Software, then press F1 or click the Help icon on the toolbar. If
you are in a dialog box, click the Help button.

B TBAOSTU/TBAOSTP CTU Operation Manual. This manual (MBA-00013-
xx) provides detailed information about the Calibration and Test Unit.

TB9100 Installation and Operation Manual (MBA-00002-xx).

TB8100 Service Manual (service centers only). A glossary of terms is available
in this manual (MBA-00016-xx).

B TB9100 Reciter Service Manual (service centers only).

For additional documentation, see the prefaces of the TB9100 Installation and
Operation Manual and the TB9100 Customer Service Software User’s Manual
or the CSS online Help.

Technical notes are published from time to time to describe applications for
Tait products, to provide technical details not included in manuals, and to offer
solutions for any problems that arise. Look for them on Tait's technical support
website.
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Publication Record

Issue Date Description
MBA-00004-01 January First release of the this manual. It describes
2005 Version 02.03 of the Tait TB9100 Calibration
Software.
MBA-00004-02 March First full release of the this manual. It
2005 describes Version 02.05 of the Tait TB9100

Calibration Software and Version 01.10 of
the TB9100 base station.

MBA-00004-03 August Minor updates. The manual describes Version
2005 02.07 of the Tait TB9100 Calibration
Software and Version 1.2 of the TB9100 base
station. Front end tuning is explained
separately for UHF and VHF receivers.

MBA-00004-04 May 2006 Describes Version 03.00 of the Tait TB9100
Calibration Software and Version 2.1x of the
TB9100 base station. Calibration for K-band
base stations, analog gateways, and receive-
only base stations. Murata tuning tool now
not used for UHF (H-band and K-band)
receiver front end, as a different helical filter
is fitted.
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Basic Tasks

The TB9100 Calibration Software is a Windows-based software program that
allows you to adjust the switching ranges of Tait TB9100 base stations (both
receiver and transmitter), and to flatten the receiver response across that
switching range.

The TB9100 Calibration Software is also used to calibrate the reciter, the PA,
and the PMU after servicing.

Using the TB9100 Calibration Software

Menu bar i

File Base Station Tools Help

When you start the TB9100 Calibration Software, the main program window
appears.

Toolbar w @ p % @
Disconnect Switch Base Station Calibrate Cptions Help
A Calbration | PMU Calibration | Show Details |
Fieciter Calibration I
I e —— Mumber [ Feciter [ Pa [ Pru |
Calibration el i 1 1 18004643 16003325 18004263
Wizards # Set Receiver ¥CO
& Tune Recsiver Front End
F Set Exciter YVCO
4] | M|
Status bar

Feady... | Port : COM1

Frequency Setup
tab

Reciter Calibration
tab

PA Calibration tab

PMU Calibration
tab

The main program window has four tabs. The Calibration Wizards displayed
on each tab are only visible once you are connected to the reciter or the base
station.

When the TB9100 Calibration Software is connected to the reciter or base
station, you can view further details (such as module number, type, serial
number, band, and hardware version) about the currently selected module by
clicking Show Details.

Shows the Calibration Wizards that take you step-by-step through the
frequency setup.

Shows the calibration procedures that you can perform on the reciter. The
Calibration Wizard takes you step-by-step through the procedure you have
selected.

Shows the calibration procedures that you can perform on the power amplifier.
The Calibration Wizard takes you step-by-step through the procedure you

have selected.

Shows the procedure that you can perform on the PMU.
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About the Toolbar

The toolbar gives you quick access to commonly used menu commands. For
example, instead of selecting Base Station > Calibrate, you can click the
Calibrate icon on the toolbar.

S g 2 B 9

Conneck Switch Base Station Calibrate Options Help

Connect Connects the TB9100 Calibration Software to the base station and opens the
communication channels.

Switch Base Lets you select another base station to calibrate if there are multiple base stations
Station in the rack (not currently supported).

Calibrate Runs the Calibration Wizard for the currently selected task.

Options Allows you to set the COM port and default calibration mode.

Help Opens the online help for the window you are currently in.

About the Status Bar

The status bar provides you with useful information that supplements the
display in the main window.

Connect to a Base Station ta begin Calibration | Port : COM1 |
Miscellaneous messages COM port in use
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Equipment Required
You need the following equipment for field calibration:
B Calibration and Test Unit (CTU, order code TBAOSTU), which comes
complete with the cables you will need for connection to the reciter/PA and

the PC. For more information about the CTU, please refer to the CTU
Operation Manual.

i

T

B Tool kit (order code TBAOST2) which comprises tuning tools and the
required screwdrivers in a tool pouch. The ceramic-tipped Murata tuning
tool is used for most procedures, but the metal-tipped Johanson 8777 tuning
tool with its narrower blade is needed for tuning the front end of H-band
and K-band receivers.

® 10-30 V DC power supply (if the PMU does not have a 12 V or 24 V
auxiliary power supply module)

B RS-232 cable
B REF attenuator (optional — depends on the setup)

You may need the following additional equipment for a service center
calibration:

B Frequency counter
B Modulation meter
® REF signal source
|

AC millivoltmeter (one with a differential input may be required for
“Calibrating the Balanced Line” on page 19)

Refer to the individual procedures for equipment setup diagrams.

Calibration Overview

Any calibration process creates digital values and a calibration date, which are
stored in the base station. The CSS can display the date of the last calibration.
Many calibration procedures initially clear the stored digital values. If you do
not complete the procedure or the stored digital values are outside acceptable
limits, the module is left uncalibrated. An uncalibrated reciter cannot be put
into Run mode. An uncalibrated PA generates a calibration invalid alarm.

If the procedure you are performing requires access to tuning holes, you need
to remove the reciter from the subrack and connect to it via the CTU.

The following tables summarize, for each procedure, whether or not you need
to remove the reciter from the subrack, and what equipment (in addition to a
PC with the TB9100 Calibration Software) you will need.
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Reciter

Power Amplifier

4| Calibration Overview

Field Calibration

The following procedures can be carried out in the field.

Procedure

Connection

Equipment Required

Adjusting receiver lock band

Outside subrack

Murata tuning tool

Tuning the receiver

Outside subrack

Murata tuning tool,
Johanson tuning tool (for H-
band and K-band reciters),
CTU

Calibrating the RSSI

Inside subrack

RF signal source

Adjusting exciter lock band

Outside subrack

Murata tuning tool

Calibrating the TCXO
(see “Carrier Frequency Offset
Adjustment” on page 20)

Outside subrack

Murata tuning tool,
Frequency counter, RF
attenuator (only if using PA)

has been serviced.

Service Center Calibration

The following additional procedures may need to be carried out after a module

Note: Replacing or repairing a board module may mean that the
module’s product code, product type (frequency band), serial
number, and/or hardware version need to be re-entered or altered.
To do this, your Calibration Software needs a dongle. The Service Manual
indicates when a module detail needs re-entering or altering.

Procedure

Connection

Equipment Required

Automatically tuning FCL

Inside subrack

None

Calibrating the FCL modulation

Outside subrack

Murata tuning tool,
modulation meter, RF
attenuator (only if using PA)

Calibrating the VCO modulation

Outside subrack

Murata tuning tool,
modulation meter, RF
attenuator (only if using PA)

Calibrating the balanced lines
(the analog line)

Inside subrack

CTU, AC millivoltmeter
(perhaps with differential
input)

Procedure

Connection

Equipment Required

Calibrating the PA bias

Inside subrack

None required

Calibrating the forward &
reverse detector bias voltages

Inside subrack

None required

Calibrating the PA power

Inside subrack

None required
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Power
Management Unit

Procedure Connection Equipment Required

Output voltage calibration Inside subrack Digital multimeter

Receive-Only Base Station Calibration

The reciter in a TB9100 receive-only base station difters only in the absence of
a Transmit enable feature license. (The TB8100 receive-only reciter is a
hardware variant with no transmit capability.) Accordingly, the calibration
software reports the reciter type as standard. You need to carry out receiver-
related calibration procedures, but you can also carry out those that apply to the
exciter, if desired.

Analog Gateway Calibration

The current analog gateway is effectively a reciter without feature licenses for
transmitting and receiving. Accordingly, the calibration software reports the
reciter type as standard. You need to carry out procedures that relate to the
analog line. You can also carry out those that apply to the receiver and the
exciter, if desired.

Selecting the Communications Port

Before you connect to a base station, you should first define the
communications (COM) port that you want to use.

To select the COM port
1. Select Tools > Options.

@ Options E

r— Communication:
COM Port: &

— Calibration Mode
{* Single base-station mode

¢ fulti base-station mode

QK I Cancel | Help |

2. Select the port that you want to use from the COM Port list.

Note: The available COM ports are detected by the program and
appear in the list.

3. Click OK.

The COM port you selected is now shown on the status bar.
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Setting Up the Equipment

For field calibration procedures, you need to remove the reciter from the
subrack to gain access to tuning holes. If a CTU is required for one procedure,
it is probably easiest to use it for all your procedures. If it is not required, you
can connect the PC directly to the reciter.

To set up the equipment

1.

Remove the reciter from the subrack, following the instructions in the
Installation and Operation Manual. (Note that for some service center
procedures, the reciter can be left in the subrack.)

Connect the reciter and the PC to the CTU according to the diagram
below.

B Connect the reciter’s analog RJ-45 socket (labeled AUD) to the CTU’s
RJ-45 using the RJ45 cable

B Connect the reciter’s 9-way serial connector (labeled DIG) to the CTU’s
9-way male connector using the 9-way cable.

m Connect your PC to the CTU by plugging an RS-232 cable into the 9-
way serial port labeled 10101.

(If you are not connecting via the CTU, connect the PC to DIG using the
RS-232 cable. No other connections are required.)

Note: Tait recommends that you disable the PC’s hardware
E handshaking. The DIG connector is used for digital I/O as well as

for RS-232 and this could interfere with the handshaking.

Alternatively, use a special DB cable that has only three connectors (for pins
2, 3, and 5).

3.

Connect the CTU to the 10-30V DC power supply using the power cable
supplied. If the base station’s PMU has a 12 V or 24 V auxiliary power
output, you can use this as the power supply. A connector is supplied with
the CTU. The reciter must also be supplied with power, but do not power
it up yet.

Power cable 500
RJ45
| Re232 BAsESTATION | L

) B AUD| | Power
=1 QDD Dern | | supply

| —_— _I ! RS-232 o

— %8

PC CTU Reciter

Connecting the Calibration Software

Before you can begin calibrating, you must establish a connection between the
calibration software and the reciter.

6 | Setting Up the Equipment
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To connect to the reciter

1. Make sure that the equipment is set up but that the reciter is not powered
up.

2. Start the TB9100 Calibration Software program, and check that the correct
COM port is selected.

3. Click Connect to start the connection process.

4. When you see the “Waiting for logon prompt from Reciter” screen, power
up the reciter. If it is already on, turn it oft, and then on.

Waiting for logon prompt from Reci

Calibration can seriously interfere with the Base Station.
It must only be camied out by trained personnel.

Please reset £ or switch the Base Station off and on
now to begin calibrating.

5. When the TB9100 Calibration Software program has successtully
connected to the reciter (this can take up to 30 seconds), the Calibration
Wizards are displayed in the main window.

You are now ready to tune and calibrate the reciter.

Disconnecting from the Base Station/Reciter

Once calibration is completed, end the process as follows.

1. Click Disconnect.

Important: Disconnecting when a calibration process is not
completed may leave the base station in an uncalibrated state.

2. Exit the Calibration Software.

3. Turn the base station off and then on again to take it out of calibration
mode. The base station is now in Standby mode, ready for configuration.

Troubleshooting

Application Errors

Verifying the
Software Version

Commands
Record

All application errors are recorded in a log file called
“CCTMCOMMSLog.log”. The data, time, location, and any other useful
information is stored in this file, which may be helpful when troubleshooting.

The file is saved in the Calibration Software’s application folder.

If you need to verify the version of the TB9100 Calibration Software, select
Help > About.

All the commands sent and received by TB9100 Calibration Software are saved
in a file called “CCTM.log”. The date, time, command number, and
parameters are all stored in this file, which may be helpful when
troubleshooting.

The file is also saved in the Logfiles subfolder and stores up to 1000 of the most
recent logged items.
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Adjusting the Frequency Setup

Before the TB9100 base station is installed, connected, and configured, you

must prepare it for operation by adjusting the switching range of the receiver,
optimizing the receiver response across the switching range, and adjusting the
exciter lock band or selecting an exciter sub-band.

Note: If the required switching range for the base station has already
& been defined, you don’t need to perform these procedures.

Tip: Use the TB9100 CSS to monitor the base station and find out
its current switching range.

@ Important: Be careful when using the tuning tool. Applying too

much pressure or attempting to turn the tool beyond the end of the
range can crack the tuning slug. Unscrewing a slug too far can

remove it completely.

Adjusting the Receiver Lock Band

The first step in preparing the TB9100 base station for operation is to adjust the

receiver lock band (switching range). The lock band is the range of frequencies

that the receiver is calibrated to operate on.

To adjust the receiver lock band

1.
2.

Set up the equipment and connect the Calibration Software to the reciter.

Select the Frequency Setup tab, and double-click Set Receiver VCO. The
Set Receiver VCO Wizard appears. The display varies, depending on the
reciter band.

Enter the Center Frequency (which must be a multiple of 500 kHz) of the
lock band that you want to use, and click Next.

Insert the Murata tuning tool into the correct receiver VCO tuning hole for
the reciter type (see below) and then click Next.

Adjust the receiver VCO trimmer until the actual band matches the desired
band. The bands turn green. Click Finish. This stores the lock band in the
reciter. The icon =%#- on the Frequency Setup tab indicates that this task is

-

complete. Proceed to tune the front end.
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Receiver VCO tuning hole for
B band (136-174 MHz)

Receiver VCO tuning hole for
H band (400-520 MHz) and
K band (792-824 MHz).

Tuning a UHF Receiver Front End

The second step in tuning the reciter frequency is to tune the receiver front
end, by adjusting the helical filters. Tuning aims to maximize the receiver’s
sensitivity and to optimize its response across the lock band (switching range).

To help you do this, there is a graph of the RSSI readings in step two of the
Tune Receiver Front End Wizard. A number of RSSI readings are measured
across the switching range. These readings are then continually averaged to
produce the graph.

Important: After tuning the reciter front end, you must re-calibrate the RSSI.
This requires a signal generator. Otherwise the value reported by the CSS will
be in error, RSSI gating levels will be incorrect in analog mode, and voting
will be inaccurate in both modes.

You should aim to achieve a response that looks something like this:

-70
75 -
=T -

- r 1

=Ty —
95 - /——L:TS\
100 —

105 —
110

15 -
120 . . . T |

dB
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Setup

= %EJZ a 6

1

1 PC 2 RS-232 cable 3 Programming port
4 CTU 5 Noise source 6 Reciter

To tune the front end of a UHF (H-band) receiver, follow these steps.

1. Make sure that the equipment is correctly set up and that the Calibration
Software is connected to the reciter.

2. Select the Frequency Setup tab, and double-click Tune Receiver Front
End. The Tune Receiver Front End Wizard appears.

Note: If you haven’t adjusted the receiver lock band in the current
= session, an alert appears, recommending that you run the Set

Receiver VCO wizard first. If the lock band needs adjusting, click
Yes and carry out that procedure first. If you are confident that the lock band
is correct, click No.

3. Connect the CTU’s noise source to the receiver input, turn the noise source
on, and then click Next.

4. Click Coarse (fast) and use the tuning tool to roughly adjust the front-end
helical filters on the receiver. As you do so, observe the graphical RSSI
readings across the lock band. Adjust to maximize the response across the
entire switching band.

: Note: For final fine tuning, you may find it helpful to select a more
.I& = sensitive scale, so that you can see the graphical reading in more

detail.

Helical
filters:

Second set

First set

Use the tuning tools as follows.
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a. Insert the Johanson tuning tool into the first hole of the first (horizontal)
set. You can start with the hole on the left side and proceed along to the
hole on the right, or vice versa. On K-band reciters, the third hole tends
to tune with the slug well out of the filter body. Be careful not to
unscrew the slug completely.

b. Tune each of the resonators in the first set once to give the best response.

c. Insert the Johanson tuning tool into the first hole of the second (vertical)
set. You can start with the top hole and proceed down to the bottom
hole, or vice versa. (For version 4.00 or earlier H-band reciters, use the
Murata tuning tool on this set instead, as instructed by the wizard.)

d. Tune each of the resonators in the second set once to give the best
response.

e. Repeat this procedure as necessary to refine the response.

5. Once you have roughly tuned the front-end helical filters, click Fine
(slow). Repeat the above procedure to fine tune the front-end helical filters
until the response is peaked in the middle of the lock band and not more

than -1 dB at the ends of the band.

Note: When using the Fine (slow) setting, you may notice a slight
delay as the reading from tuning the front-end helical filters takes
approximately one second to appear on the graph.

!

6. Click Finish. An alert appears, asking that you calibrate the RSSI. The icon
4 on the Frequency Setup tab indicates that this task is complete.

7. Re-calibrate the RSSI (see “Calibrating the RSSI” on page 18).

Tuning a VHF Receiver Front End

The second step in tuning a VHF reciter is to tune the receiver front end, by
adjusting trimmer capacitors. Tuning aims to maximize the receiver’s sensitivity
and to optimize its response across the lock band (switching range).

To help you do this, there is a graph of the RSSI readings in step two of the
Tune Receiver Front End Wizard. A number of RSSI readings are measured
across the switching range. These readings are then continually averaged to

produce the graph.

Important: After tuning the reciter front end, you must re-calibrate the RSSI.
This requires a signal generator. Otherwise the value reported by the CSS will
be in error, RSSI gating levels will be incorrect in analog mode, and voting
will be inaccurate in both modes.

You should aim to achieve a response that looks something like this:

Graph of signal strength within synthesizer lock

-7l

| |
a0 - | |
5 - | |
90 | |
dB g5 _,-—-"":___':'_‘_N
100 —
05 —
10—
15 —
1200 | I I | |
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Setup

= %EJZ a 6

1

1 PC 2 RS-232 cable 3 Programming port
4 CTU 5 Noise source 6 Reciter

To tune a VHF (B-band) receiver front end, follow these steps.

1. Make sure that the equipment is correctly set up and that the Calibration
Software is connected to the reciter.

2. Select the Frequency Setup tab, and double-click Tune Receiver Front
End. The Tune Receiver Front End Wizard appears.

Note: If you haven’t adjusted the receiver lock band in the current
= session, an alert appears, recommending that you run the Set
Receiver VCO wizard first. If the lock band needs adjusting, click
Yes and carry out that procedure first. If you are confident that the lock band
is correct, click No.

3. Connect the CTU’s noise source to the receiver input, turn the noise source
on, and then click Next.

4. Click Coarse (fast) and use the Murata tuning tool to roughly adjust the
four front-end trimmers on the receiver (see below). You can do this in any
order. As you do so, observe the graphical RSSI readings across the lock
band. Adjust to optimize the response across the entire switching band.

: Note: For final fine tuning, you may find it helpful to select a more
& sensitive scale, so that you can see the graphical reading in more
detail.

5. Once you have roughly tuned the trimmers, click Fine (slow). Repeat the
above procedure until the response is flat in the middle of the lock band and
not more than -1 dB at the ends of the band.

Note: When using the Fine (slow) setting, you may notice a slight
I: delay as the reading from tuning the trimmers takes approximately
one second to appear on the graph.

6. Click Finish. An alert appears, asking that you calibrate the RSSI. The icon
- on the Frequency Setup tab indicates that this task is complete.

7. Re-calibrate the RSSI (see “Calibrating the RSSI” on page 18).
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Trimmer holes for receiver
front-end tuning
(B band 136-174 MHz)

Adjusting the Exciter Lock Band

If you are preparing the base station for operation, adjusting the exciter lock
band is the third step in tuning the reciter. Alternatively, this procedure can be
performed independently of the other two calibration wizards on the
Frequency Setup tab. Adjusting the exciter lock band defines the range of
frequencies that the base station is able to transmit on.

Note: When performing this procedure, you don’t need to
terminate the exciter output port. An internal output pad means that
there is a good impedance match at this interface.

To calibrate the exciter lock band
1. Set up the equipment and connect the Calibration Software to the reciter.

2. Select the Frequency Setup tab, and double-click Set Exciter VCO. The
Set Exciter VCO Wizard appears.

3. Enter the center frequency (which must be a multiple of 500 kHz) of the
lock band that you want to use, and click Next.

4. Insert the Murata tuning tool into the correct exciter VCO tuning hole (see
below) and adjust the trimmer until the actual band matches the desired
band. The bands turn green. Click Finish.

LA—_

Once you have finished adjusting the exciter lock band, the icon Zﬁ': on the
Frequency Setup tab indicates that this task is complete.

Exciter VCO tuning hole Exciter VCO tuninc
for H band = hole for B band
(400-520 MHz) (136-174 MHz)

S
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Selecting the Exciter Sub-band

The lock band of K-band exciters does not normally need adjusting. Instead
you select a sub-band that the reciter will operate on. These exciters have two
VCOs and the one you select determines the sub-band.

Equipment B Murata tuning tool
m CTU

To select the exciter sub-band

1. Ensure you are already connected to the reciter (see “Connecting to a
Reciter Outside the Subrack” on page 5).

2. Select the Frequency Setup tab, and double-click Set/Select Exciter
VCO. The Set/Select Exciter VCO Wizard appears.

3. Select one of the two available lock bands and then click Next. This
specifies the lock band that the exciter operates in.

4. If the reciter RF board has been repaired, you need to adjust the lock band.
Insert the Murata tuning tool into the correct exciter VCO tuning hole (see
below) and adjust the trimmer until the actual band matches the desired
band. The bands turn green.

5. Click Finish.

Once you have finished, the icon Z'ﬁ'-.' on the Frequency Setup tab indicates that
this task is complete.

Exciter VCO tuning hole for
K band (850-869 MHz)

Exciter VCO tuning hole for
K band (762-776 MHz)
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Calibrating the Reciter

The reciter is fully calibrated in the factory, but if the reciter is serviced you may
need to perform the following procedures:

m Calibrating the Exciter

m Calibrating the RSSI

B Calibrating the Balanced Line

To compensate for frequency drift, you may need to perform the following:
m Carrier Frequency Offset Adjustment

All these procedures can be done independently of each other, although it is
recommended that you tune the receiver before you calibrate the RSSI.

Important: It is recommended that only accredited service centers
and Tait engineers perform these procedures.

Calibrating the Exciter

Equipment

You will need to calibrate the exciter if you have made component-level repairs
to it. There are three steps:

1. Auto-tune the FCL
2. Calibrate the FCL
3. Calibrate the VCO

Automatically Tune the Frequency Control Loop (FCL)
Tuning the FCL calibrates the voltage levels used in the detectors for the FCL.

To automatically tune the FCL
1. Set up the equipment and connect the Calibration Software to the reciter.

2. Select the Reciter Calibration tab, and double-click FCL Auto Tuning.
The FCL Auto Tuning Wizard appears.

3. Click Calibrate to automatically tune the FCL.
The icon '.-@: on the Reciter Calibration tab indicates that this task is complete.

You will now need to calibrate the FCL.

Calibrating the FCL

This is step two of calibrating the exciter. Once you have auto-tuned the FCL,
you should calibrate it.

B Murata tuning tool
B Modulation meter

m REF attenuator (only required if you are using a PA)
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Setup

16 | Calibrating the Exciter

3
1 VAVA
4
1 Reciter 3 RF attenuator (only required if using a PA)
2 PA (optional) 4 Modulation meter

To calibrate the FCL

1.

Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the Reciter Calibration tab, and double-click FCL Calibration. The
FCL Calibration Wizard appears.

3. Attach an appropriate Load and Modulation meter to the PA or exciter
output, set the meter to measure the RMS deviation, and then click Next.
(If you are using a PA, it will now transmit.)

4. Insert the tuning tool into the correct exciter VCO tuning hole (see below)
and adjust the trimmer until the actual band matches the desired band. The
bands turn green. Click Next.

5. Use the slider to adjust the deviation at 1 kHz until it is 2107 Hz RMS
(3 kHz peak).

6. Select the 30 Hz Modulation Test and adjust the deviation at 30 Hz until it
is 2107 Hz RMS (3 kHz peak).

7. Repeat steps 5 and 6 until the deviation is 2107 Hz RMS at both 1 kHz and
30 Hz.

8. Click Finish. (If you are using a PA, it will now stop transmitting.)

‘When you have finished calibrating the FCL, the icon ﬁ' on the Reciter
Calibration tab indicates that this task is complete.

You will now need to calibrate the VCO.

Exciter VCO tuning hole for

Exciter VCO tuning hole B band (136-174 MHz)

for H band
(400-520 MHz)

Exciter VCO tuning hole for
K band (850-869 MHz)

Exciter VCO tuning hole for
K band (762-776 MHz)
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Equipment

Setup

Calibrating the VCO

This is step three of calibrating the exciter.

Once you have tuned and calibrated the FCL, you calibrate the VCO at
frequencies across the whole lock band. This involves selecting a sub-band,
adjusting the lock band trimmer, and then moving on-screen sliders to adjust
the deviation to 3 kHz for each of a set of frequencies.

B Murata tuning tool
B Modulation meter

m REF attenuator (only required if you are using a PA)

1 Reciter 3 RF attenuator (only required if using a PA)
2 PA (optional) 4 Modulation meter

To calibrate the VCO

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the Reciter Calibration tab, and double-click VCO Calibration.
The VCO Calibration Wizard appears.

3. Attach an appropriate Load and Modulation meter to the PA or exciter
output, set the meter to measure the peak deviation, and then click Next.
(If you are using a PA, it will now transmit.)

4. Adjust the exciter lock band trimmer until the actual band matches the
desired band. The bands turn green.

5. Click Next. Step 3 of the wizard appears.
6. Calibrate each of the frequencies shown. Follow these steps.

a. Click the option button alongside a frequency.

b. Using the Fine and Coarse arrows, adjust the slider until the deviation
shown on the modulation meter is 3000 Hz (peak).

c. Repeat steps a) and b) until all frequencies for the band are calibrated.
This enables the Next Band button.

7. Click Next Band and repeat steps 4) through 6). Repeat until all
frequencies in all bands have been calibrated.

8. If you are connected to a K-band reciter, click Next. Select which of the
two available bands the reciter will operate on.

9. Click Finish. (If you are using a PA, it will now stop transmitting.)

‘When you have finished calibrating the VCO, the icon Zﬁ: on the Reciter
Calibration tab indicates that this task is complete.
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You should now adjust the exciter lock band because it was re-tuned several
times during this procedure. This means that the exciter is no longer on the
required frequency.

Calibrating the RSSI

Equipment

Setup

18 | Calibrating the RSSI

Calibrating the RSSI (received signal strength indicator) ensures that the
reciter's internal RSSI values accurately reflect the actual received signal
strength. Changing the receiver's lock band can alter the calibration accuracy by

about 1 dB.

Note: Ensure that the receiver’s lock band has already been adjusted
= to the required setting before carrying out this procedure. (See
“Adjusting the Receiver Lock Band” on page 8.)

m REF signal source

1
v

1 RFsignal source
2 Reciter

To calibrate the RSSI

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the Reciter Calibration tab, and double-click RSSI Calibration. An
alert appears, recommending that you tune the receiver. If the receiver
needs tuning, click Yes and carry out that procedure before continuing.

If you are confident that the receiver is correctly tuned, click No. The RSSI
Calibration Wizard appears.

3. Apply asignal (modulated at 1 kHz tone, 3kHz deviation peak) at the base
station’s center frequency. Use the CTU to confirm that the tone is being
output on the line, and then click Next.

4. Set the RF input signal to a level of -80 dBm, and then click Next.

5. Vary the RF level, and check that the value shown in the RSSI Gain Setting
box corresponds with the value shown on your test instrument. This is to
make sure the RSSI is correctly calibrated. Click Finish.

When you have finished calibrating the RSSI, the icon '.-@-.' on the Reciter
Calibration tab indicates that this task is complete.
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Calibrating the Balanced Line

This procedure is carried out on the analog line if the reciter network board has
been replaced or repaired. It adjusts the gain, so that when you set line levels
using the TB9100 CSS, the actual line level correctly reflects the CSS settings.
(Refer to the TB9100 Customer Service Software User’s Manual for turther
information.)

Equipment m CTU

B AC millivoltmeter

Setup for Line Out

AC milli-
Power @ voltmeter

supply
Power |cable O O
Line )
RS-232 BASESTATION  oitput
] el - [SAUD
| DJ RJ45
- — |02 Q DETH
= | P
PC CTU Reciter
Setup for Line In
Power
voltmeter
supply
Power |cable V/\ O O
Oneinput  Line )
RS-232 BASESTATION  qutput
| CALIBRATION TEST UNIT Q E}AU D
- DJ RJ45
-;.=.=,_|_ _ D [YETH
= | DI
+—Hrs

To calibrate the analog input and output lines

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the Reciter Calibration tab, and double-click Balanced Line
Calibration. The Balanced Line Calibration Wizard appears.

3. Attach an AC millivoltmeter and terminate the output in 600 ohms (either
using the load on the CTU or looping the balanced output to the balanced
input), and then click Next.
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4. Adjust the slider in the dialog box until the audio level on the millivoltmeter
reads 1 Vpp (0.354 VRMS).

Note: Click Coarse to roughly adjust the audio level, and once you
.I& = get within range, click Fine for more precise control over the
settings. To move up or down 10 mVPp, click either side of the

slider bar.
5. Click Next. The balanced output is now calibrated.

6. Note the level of the AC millivoltmeter, and then turn off the 600 ohm
load.

7. Connect the analog output to the analog input. Verify that the
millivoltmeter reading is substantially unchanged. (This confirms that the
input provides a 600 ohm impedance.)

8. Click Finish. The balanced input is now calibrated.

‘When you have finished calibrating the analog line, the icon Zﬁ: on the
Reciter Calibration tab indicates that this task is complete.

Calibrating the Unbalanced Lines

This procedure is not carried out on the TB9100. The TB9100 does not have
an unbalanced line.

Carrier Frequency Offset Adjustment

The TCXO (temperature compensated crystal oscillator) provides a reference
frequency from which all other RF frequencies are derived. TB9100 reciters
have a voltage-controlled TCXO with a pot for adjusting the reference
frequency to remove any carrier frequency offset. The Carrier Freq Offset
Adjustment wizard provides assistance with this procedure.

This procedure is not normally needed in the field for VHF base stations. For
UHF and above, Tait recommends that the reciter TCXO is checked after 3
months service and adjusted if the error is > 0.5 ppm.

Annual checks should be made thereafter to detect any frequency drift. The
reciter TCXO should only be adjusted if the actual transmit frequency has
drifted more than 0.5 ppm from the configured value.

Tait recommends that the TCXO is calibrated to within 0.1 ppm.
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Equipment [ |

Setup

Torx 10 screwdriver (to remove the reciter cover)
Tuning tool

Frequency counter with an accuracy of 50 parts per billion or better. The
equipment must either have its own internal high-accuracy reference or be
locked to an external reference such as the Tait T805.

RF attenuator (only required if you are using a PA)

as good as the accuracy of the frequency counter.

@ Important: The accuracy of the calibrated TCXO frequency is only

Reciter 3 RF Attenuator pad (optional)
PA (optional) 4 Frequency counter

You need direct access to the TCXO circuitry on the reciter RF board. This
involves removing the reciter RF cover.

damage from static charges. You must handle these devices
according to the recommended ESD precautions.

@ Important: The reciter contains devices that are susceptible to

To adjust the carrier frequency

1.
2.

Remove the reciter from the subrack.

Remove the M3 Torx screws securing the reciter RF cover to the heatsink
and to the front and rear panels. (The RF side of the reciter can be identified
by the two BNC connectors on that side of the reciter’s rear.) Lift off the
RF cover.

. Make sure that the equipment is set up and that the Calibration Software is

connected to the reciter.

Select the Reciter Calibration tab, and double-click Carrier Freq Offset
Adjustment. The Carrier Freq Offset Adjustment wizard appears.

. Attach an appropriate load and frequency counter (or a test set) to the exciter

or PA output, and then click Next.

The exciter now begins transmitting on the center frequency of its lock
band. The Wizard displays a message similar to the following:
“Adjust RV1400 to set frequency within 0.1ppm or 48Hz of 485 MHz”

. Use the tuning tool to adjust the TCXO tuning control (RV1400) so that

the reciter is transmitting exactly on frequency.

The following shows where the tuning control is located on B-band and H-
band reciters:
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The following shows where the tuning control is located on K-band
reciters:

7. Click Finish. Transmission ceases and the icon Zﬁ: on the Reciter
Calibration tab indicates that this task is complete.

8. Replace the reciter RF cover, as follows.

a. Slide the cover into place over the front and rear panels. Make sure the
holes in the cover line up with the threaded holes in the heatsink and
front and rear panels.

b. Press the cover firmly into place and screw in the M3 Torx screws, first
on the flat face, then on the edge face.

Important: Excessively tightening the screws can damage the thread
of the aluminium heatsink. Tait recommends that you use a T10
torque driver set to 0.5 Newton meters (4.5 foot pounds).
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Calibrating the Power Amplifier

The PA is fully calibrated in the factory, but if the PA is serviced you may need
to perform the following procedures:

m Calibrating the PA Bias

m Calibrating the Forward and Reverse Detector Bias Voltages
m Calibrating the PA Power

Perform the procedures in the above order.

@ Important: It is recommended that only accredited service centers

and Tait engineers perform these procedures.

Calibrating the PA Bias

The driver and final transistors of the power amplifier must be biased at a
constant current. Since the characteristics of individual transistors vary slightly,
the bias current is calibrated for each device.

If either the driver or final transistor, or the PCB modules themselves, are
replaced during servicing, you should perform this procedure to calibrate the
bias current for the new device.

The bias current required for each amplifier stage is stored within the PA.
During the calibration process, the microprocessor adjusts the gate bias voltage
to obtain the required bias current for each stage.

The stage bias calibration sets up the amplifier’s DC operating conditions.
These DC conditions will be upset if there is RF present during calibration. It
is important to disconnect the RF cable from the PA input to avoid this.

The other conditions which must be met to ensure a successful calibration are
as follows:

B No other Calibration Wizards are running
B The supply voltage is within the range 27-29V
B The temperature of each stage is within the range 5-50°C

To calibrate the PA stage bias current

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the PA Calibration tab, and double-click Calibrate PA Bias.

3. Ensure that the exciter RF is isolated from the PA by disconnecting the
SMA connector on the PA front panel.

4. Click Calibrate to calibrate the PA bias.

When you have finished calibrating the power amplifier bias, the icon ?@: on
the PA Calibration tab indicates that this task is complete.
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Calibrating the Forward and Reverse Detector Bias Voltages

The RF detectors, used for measuring the forward and reverse power, operate
with a small bias current. The resulting bias voltage from each detector (with

no RF present) is read and stored inside the PA. These voltages are used when
calculating the Antenna VSWR (Voltage Standing Wave Ratio).

You should calibrate the forward and reverse detector bias voltages:
W If the Low Pass Filter (LPF)/directional coupler PCB module is replaced

B After servicing of any components in the detector circuitry (such as the
detector diodes) on the LPF/ directional coupler PCB

To calibrate the forward and reverse detector bias voltages

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the PA Calibration tab, and double-click Calibrate Fwd/Rev
Detector Bias Voltages.

3. Ensure that the PA is not transmitting and that there is no RF source present
at the PA RF input or output by disconnecting the input SMA connector
on the PA front panel and the ‘N’ type output connector from the rear of
the PA. Click Calibrate.

‘When you have finished, the icon '.-@-.' on the PA Calibration tab indicates that
this task is complete.

Calibrating the PA Power

The power amplifier (PA) receives the RF signal from the reciter and amplifies
it to the required level, in watts, as requested by the reciter. The desired output
power is determined by the reference voltage for the power control loop.

The PA power control loop is calibrated at a single frequency, generally in the
center of the operating band.

You perform the calibration procedure to define — for each power level — the
reference DAC (Digital-to-Analog Converter) value and forward detector
voltage.

You should only need to re-calibrate the PA power if:
B The Low Pass Filter (LPF)/directional coupler PCB module is replaced

B Any repairs are carried out on the forward and reverse detector circuitry on
the Low Pass Filter/directional coupler PCB module

B You require a more accurate power calibration on a specific frequency
Equipment
W Lither an inline power meter and 50 ohm load with a high power rating, or

B A terminating power meter and appropriate 50 ohm attenuator with a high
power rating
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Setup for Inline
Power Meter

3 A\

4

[

1 Reciter 3 PA 5 Load

2 16-way cable 4 RF Power Meter

Note: Cables and connectors can easily cause a power loss of several
watts if either too long or poorly terminated. Always use the
shortest possible leads (or connectors instead of leads) between the
PA and power meter set-up.

To calibrate the PA transmit power

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the PA Calibration tab, and select Calibrate PA Power.

3. Ensure that the power meter and a 50 ohm load (VSWR < 1.2:1) with a
high power rating are connected to the power amplifier RF output, and
then click Next.

4. Check that the PA RF input is connected to the reciter RF output, and that
the PA and the reciter are connected by a control bus, and then click Next.

5. For each power level shown, use the slider to adjust the DAC setting to get
the required power output, and then click Next Power to move to the next

line.

L) [

Note: Click Coarse to roughly adjust the DAC setting, and once
you get within range, click Fine for more precise control over the
settings. To move up or down one DAC value, click either side of
the slider bar.

Note: You must perform the calibration in sequence from the lowest
to the highest step. The DAC setting must be greater than the
previous one otherwise the value will not be stored in the PA, and
you cannot move to the next line.

6. When you have completed adjusting the DAC settings, click Finish.

When you

have finished, the icon '.-@-.' on the PA Calibration tab indicates that

this task is complete.
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Troubleshooting Tips

DAC Settings When you adjust the DAC settings, the values for the DAC Setting, Coupler
Fwd Voltage, and Control Voltage should always increase as the power level
increases. If these values do not increase, there is either a fault with the PA or
the previous step was not calibrated correctly. If you make a mistake in the
calibration table, you must start again from step 1.

Control Voltage The Control Voltage is shown in the table to indicate the operation point
within the power control loop. The range of the control voltage is from 0 V to
7.5 V. If the control voltage reaches its limit before achieving maximum power
in the table, this indicates either a faulty gain stage in the PA or low RF input
power to the PA.

VSWR The VSWR (Voltage Standing Wave Ratio) is monitored at the RF output of
the PA during calibration. The software will not allow calibration into a load
VSWR > 1.3:1. If a calibration step cannot be stored, check that the load
VSWR is <1.3:1. It is recommended that the load should have an input
VSWR <1.2:1.
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Calibrating the Power Management Unit

There is only one calibration procedure for the PMU: calibrating its output
voltage.

Calibrating the PMU Output Voltage

Calibrating the PMU output voltage adjusts the voltage to be 28.00 V. This
procedure is only carried out when a replacement control card or
microprocessor is fitted to the PMU. Normally, the output voltage will be
accurate without calibration.

Note: Re-calibrating the PMU output voltage may in fact result in
.: it failing to meet the published specification of +/- 0.5% accuracy.

This is because control cards are calibrated in the factory under half-
load, giving a voltage that is closer to 28.00 V under varying loads.

To calibrate the output voltage

1. Make sure that the equipment is set up and that the Calibration Software is
connected to the reciter.

2. Select the PMU Calibration tab.

3. Double-click Output Voltage Calibration. The Calibrate Output
Voltage wizard appears.

4. Connect a digital multimeter to the PMU output and read the output
voltage.

5. Enter the voltage into the PMU Voltage box and click Calibrate.

6. When the wizard indicates that the calibration completed successfully, click
Finish.
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Tait General Software Licence Agreement

This legal document is an Agreement between you (the
“Licensee”) and Tait Electronics Limited (“Tait”). By using any
of the Software or Firmware items prior-installed in the related
Tait product, included on CD or downloaded from the Tait
website, (hereinafter referred to as “the Software or Firmware”)
you agree to be bound by the terms of this Agreement. If you do
not agree to the terms of this Agreement, do not install and use
any of the Software or Firmware. If you install and use any of the
Software or Firmware that will be deemed to be acceptance of the
terms of this licence agreement.

The terms of this Agreement shall apply subject only to any
express written terms of agreement to the contrary between Tait
and the Licensee.

Licence

TAIT GRANTS TO YOU AS LICENSEE THE NON-EXCLUSIVE
RIGHT TO USE THE SOFTWARE OR FIRMWARE ON A SINGLE
MACHINE PROVIDED YOU MAY ONLY:

1. COPY THE SOFTWARE OR FIRMWARE INTO ANY MACHINE
READABLE OR PRINTED FORM FOR BACKUP PURPOSES IN
SUPPORT OF YOUR USE OF THE PROGRAM ON THE SINGLE
MACHINE (CERTAIN PROGRAMS, HOWEVER, MAY INCLUDE
MECHANISMS TO LIMIT OR INHIBIT COPYING, THEY ARE
MARKED “COPY PROTECTED”), PROVIDED THE COPYRIGHT
NOTICE MUST BE REPRODUCED AND INCLUDED ON ANY SUCH
COPY OF THE SOFTWARE OR FIRMWARE;

AND / OR

2. MERGE IT INTO ANOTHER PROGRAM FOR YOUR USE ON
THE SINGLE MACHINE (ANY PORTION OF ANY SOFTWARE OR
FIRMWARE MERGED INTO ANOTHER PROGRAM WILL
CONTINUE TO BE SUBJECT TO THE TERMS AND CONDITIONS
OF THIS AGREEMENT).

THE LICENSEE MAY NOT DUPLICATE, MODIFY, REVERSE
COMPILE OR REVERSE ASSEMBLE ANY SOFTWARE OR
FIRMWARE IN WHOLE OR PART.

Important Notice

THE SOFTWARE OR FIRMWARE MAY CONTAIN OPEN SOURCE
SOFTWARE COMPONENTS (“OPEN SOURCE COMPONENTS”).
OPEN SOURCE COMPONENTS ARE EXCLUDED FROM THE
TERMS OF THIS AGREEMENT EXCEPT AS EXPRESSLY STATED IN
THIS AGREEMENT AND ARE COVERED BY THE TERMS OF THEIR
RESPECTIVE LICENCES WHICH MAY EXCLUDE OR LIMIT ANY
WARRANTY FROM OR LIABILITY OF THE DEVELOPERS AND/OR
COPYRIGHT HOLDERS OF THE OPEN SOURCE COMPONENT
FOR THE PERFORMANCE OF THOSE OPEN SOURCE
COMPONENTS. YOU AGREE TO BE BOUND BY THE TERMS AND
CONDITIONS OF EACH SUCH LICENCE. FOR MORE
INFORMATION SEE:
http://support.taitworld.com/go/opensource

Title to Software

THIS AGREEMENT DOES NOT CONSTITUTE A CONTRACT OF
SALE IN RELATION TO THE SOFTWARE OR FIRMWARE SUPPLIED
TO THE LICENSEE. NOT WITHSTANDING THE LICENSEE MAY
OWN THE MAGNETIC OR OTHER PHYSICAL MEDIA ON WHICH
THE SOFTWARE OR FIRMWARE WAS ORIGINALLY SUPPLIED, OR.
HAS SUBSEQUENTLY BEEN RECORDED OR FIXED, IT IS A
FUNDAMENTAL TERM OF THIS AGREEMENT THAT AT ALL
TIMES TITLE AND OWNERSHIP OF THE SOFTWARE OR
FIRMWARE, WHETHER ON THE ORIGINAL MEDIA OR
OTHERWISE, SHALL REMAIN VESTED IN TAIT OR THIRD
PARTIES WHO HAVE GRANTED LICENCES TO TAIT.

Term and Termination

THIS LICENCE SHALL BE EFFECTIVE UNTIL TERMINATED IN
ACCORDANCE WITH THE PROVISIONS OF THIS AGREEMENT.
THE LICENSEE MAY TERMINATE THIS LICENCE AT ANY TIME BY
DESTROYING ALL COPIES OF THE SOFTWARE OR FIRMWARE
AND ASSOCIATED WRITTEN MATERIALS. THIS LICENCE WILL BE
TERMINATED AUTOMATICALLY AND WITHOUT NOTICE FROM
TAIT IN THE EVENT THAT THE LICENSEE FAILS TO COMPLY
WITH ANY TERM OR CONDITION OF THIS AGREEMENT. THE
LICENSEE AGREES TO DESTROY ALL COPIES OF THE SOFTWARE
OR FIRMWARE AND ASSOCIATED WRITTEN MATERIALS IN THE
EVENT OF SUCH TERMINATION.

TB9100 Calibration Software User's Manual

Limited Warranty

THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE
COMPONENTS) IS SUPPLIED BY TAIT AND ACCEPTED BY THE
LICENSEE “AS IS” WITHOUT WARRANTY OF ANY KIND EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT BEING LIMITED
TO ANY IMPLIED WARRANTIES AS TO MERCHANTABILITY OR
FITNESS FOR ANY PARTICULAR PURPOSE. THE LICENSEE
ACKNOWLEDGES THAT THE SOFTWARE OR FIRMWARE
(INCLUDING OPEN SOURCE COMPONENTS) IS USED BY IT IN
BUSINESS AND ACCORDINGLY TO THE MAXIMUM EXTENT
PERMITTED BY LAW NO TERMS OR WARRANTIES WHICH ARE
IMPLIED BY LEGISLATION SHALL APPLY TO THIS AGREEMENT.
TAIT DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED
IN THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE
COMPONENTS) WILL MEET THE LICENSEE’S REQUIREMENTS OR
THAT THE OPERATION OF THE SOFTWARE OR FIRMWARE
(INCLUDING OPEN SOURCE COMPONENTS) WILL BE
UNINTERRUPTED OR ERROR FREE.

Exclusion of Liability

IN NO CIRCUMSTANCES SHALL TAIT BE UNDER ANY LIABILITY
TO THE LICENSEE, OR ANY OTHER PERSON WHATSOEVER,
WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT
(EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT),
EQUITY, UNDER ANY STATUTE, OR OTHERWISE AT LAW FOR
ANY LOSSES OR DAMAGES WHETHER GENERAL, SPECIAL,
EXEMPLARY, PUNITIVE, DIRECT, INDIRECT OR
CONSEQUENTIAL ARISING OUT OF OR IN CONNECTION WITH
ANY USE OR INABILITY OF USING THE SOFTWARE OR
FIRMWARE (INCLUDING OPEN SOURCE COMPONENTS).

THE LICENSEE’S SOLE REMEDY AGAINST TAIT WILL BE LIMITED
TO BREACH OF CONTRACT AND TAIT’S SOLE AND TOTAL
LIABILITY FOR ANY SUCH CLAIM SHALL BE LIMITED AT THE
OPTION OF TAIT TO THE REPAIR OR REPLACEMENT OF THE
SOFTWARE OR FIRMWARE OR THE REFUND OF THE PURCHASE
PRICE OF THE SOFTWARE OR FIRMWARE.

General

THE LICENSEE CONFIRMS THAT IT SHALL COMPLY WITH THE
PROVISIONS OF LAW IN RELATION TO THE SOFTWARE
OR FIRMWARE.

Law and Jurisdiction

THIS AGREEMENT SHALL BE SUBJECT TO AND CONSTRUED IN
ACCORDANCE WITH NEW ZEALAND LAW AND DISPUTES
BETWEEN THE PARTIES CONCERNING THE PROVISIONS
HEREOF SHALL BE DETERMINED BY THE NEW ZEALAND
COURTS OF LAW. PROVIDED HOWEVER TAIT MAY AT ITS
ELECTION BRING PROCEEDINGS FOR BREACH OF THE TERMS
HEREOF OR FOR THE ENFORCEMENT OF ANY JUDGEMENT IN
RELATION TO A BREACH OF THE TERMS HEREOF IN ANY
JURISDICTION TAIT CONSIDERS FIT FOR THE PURPOSE OF
ENSURING COMPLIANCE WITH THE TERMS HEREOF OR
OBTAINING RELIEF FOR BREACH OF THE TERMS HEREOF.

No Dealings

THE LICENSEE MAY NOT SUBLICENSE, ASSIGN OR TRANSFER
THE LICENCE OR THE PROGRAM EXCEPT AS EXPRESSLY
PROVIDED IN THIS AGREEMENT. ANY ATTEMPT OTHERWISE TO
SUBLICENSE, ASSIGN OR TRANSFER ANY OF THE RIGHTS,
DUTIES OR OBLIGATIONS HEREUNDER IS VOID.

No Other Terms

THE LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS
AGREEMENT, UNDERSTANDS IT AND AGREES TO BE BOUND BY
ITS TERMS AND CONDITIONS. THE LICENSEE FURTHER AGREES
THAT SUBJECT ONLY TO ANY EXPRESS WRITTEN TERMS OF
AGREEMENT TO THE CONTRARY BETWEEN TAIT AND THE
LICENSEE THIS IS THE COMPLETE AND EXCLUSIVE STATEMENT
OF THE AGREEMENT BETWEEN IT AND TAIT IN RELATION TO
THE SOFTWARE OR FIRMWARE WHICH SUPERSEDES ANY
PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN AND
ANY OTHER COMMUNICATIONS BETWEEN THE LICENSEE AND
TAIT RELATING TO THE SOFTWARE OR FIRMWARE.
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Index

A

AC millivoltmeter 3
analog gateway 5
analog line, calibrating 19
audio level

calibrating 20

B

Balanced Line Calibration Wizard 19
band 1

entering 4
base station

disconnecting from 7

receive only 5

C

Calibrate Fwd/Rev Detector Bias Voltages
Wizard 24
Calibrate Output Voltage wizard 27
Calibrate PA Bias Wizard 23
Calibrate PA Power Wizard 25
Calibration and Test Unit 3
connecting up 6
calibration wizards 1
FCL Auto Tuning Wizard 15
RSSI Calibration Wizard 18
Set Exciter VCO Wizard 13, 14
Tune Receiver Front End Wizard 10, 12
Carrier Freq Offset Adjustment Wizard 21
carrier frequency, calibrating 20
COM port, selecting 5
control voltage 26
coupler fwd voltage 26
CTU

connecting up 6

E

equipment 3
tuning tool 14

exciter
adjusting lock band 13
calibrating 15, 15
component repairs to 15

TB9100 Calibration Software User's Manual

F

FCL (Frequency Control Loop)
calibrating 15
FCL Calibration Wizard 16
frequency
defining range of 13

G

gate bias voltage, adjusting 23

H

hardware version
entering 4

J

Johanson 8777 tuning tool 3

L

lock band
adjusting on exciter 13
adjusting on receiver 8
log files
application errors 7
commands received and sent 7

M

module number 1
Murata tuning tool 3

P

PA
calibrating bias current 23
calibrating transmit power 24
faulty gain stage 26
low RF input power 26
viewing details of 1
PMU
calibrating output voltage 27
power supply 3
product code
entering 4

R

receive-only base station 5
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receiver
adjusting lock band 8
tuning front end helical filters 9, 11
reciter
calibrating 15
connecting to (outside subrack) 6
tuning the frequency 8
viewing details of 1
Reference DAC 24
resonators
see front end helical filters
REF attenuator
see equipment
RF detectors
calibrating bias voltage of 24
RMS deviation, measuring 16
RSSI (Received Signal Strength Indicator)
tuning receiver 9, 11

S

serial number 1
entering 4
Set Receiver VCO Wizard 8
status bar 2
switching range
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adjusting 8
definition 8

T

TCXO (Temperature Compensated Crystal
Oscillator)
calibrating 20

tool kit 3

toolbar 2

troubleshooting 7
PA power calibration 26

tuning tool 3

A\

VCO Calibration Wizard 17

version
of Calibration Software 7

VSWR
calibrating bias voltages used to calculate 24
may prevent calibration 26

W

wizards 1
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